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 Evolution of Computers

OneOne LearnTouch

A.	 1. a.	 2. c.	 3. c.	 4. a.	 5. b.

B.	 1. Charles Babbage	 2. Lady Ada Lovelace	 3. John Mauchly      4. IBM      5. ENIAC

C.	 1. F	 2. F	 3. F	 4. F

ItLet's Do

A.	 1.	� The people used to calculate or count with the help of fingers, toes, pebbles, stones, sticks 
and bones in earlier times. 

	 2.	 Fourth generation of computers used microprocessors. 
	 3.	 Charles Babbage invented Analytical Engine.
	 4.	 Computers have zero IQ and hence lack the decision making power.
B.	 1.	 First Generation Computers Second Generation Computers

a. � First generation computers were 
made up of vacuum tubes.

a. � Second generation computers were made 
up of transistors.

b. � They were huge in size and very 
expensive.

b. � They were small in size and less expensive 
than the first generation computers.

	 2.	 a. �ENIAC was the first electronic general purpose digital computer built in 1946 by John 
Mauchly and Presper Eckert. It contained over 18,000 vacuum tubes and was 1000 times 
faster than Mark-I.

		  b. �Abacus is a wooden frame with beads on parallel wires which can do simple calculations 
like addition and subtraction. It was invented about 3000 years ago, in China to calculate 
numbers at a fast speed.

	 3.	 Features of fifth-generation computers are:
		  a. Use artificial intelligence.
		  b. Improved size, cost, speed and performance.
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	 4.	 Any two characteristics of computers are:
		  a. �Reliability: Computer does not make mistakes. If the input is correct, then the computer 

always gives the relevant answer to the input.
		  b. Power of remembering: The data stored in the computer can be recalled at any time.
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A.	 1. Charles Babbage- Difference Engine and Analytical Engine 
	 2. John Mauchly- ENIAC and UNIVAC 
	 3. Blaise Pascal- Pascaline 
	 4. Herman Hollerith- Tabulating machine
	 5. Gottfried Wilhelm Leibniz- Step Reckoner 

B.	 1. First mechanical Calculator- 1642 
	 2. First Electronic Computer- 1946 
	 3. First mechanical computer- 1833
	 4. First version of Microsoft Windows released- 1985
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 Computer Software

OneOne LearnTouch

A.	 1. c.	 2. c.	 3. b.	 4. c.	 5. c.
B.	 1. T	 2. F	 3. F	 4. F
C.	 1. System software	 2. Operating system	 3. Application software	 4. Disk defragmenter
	 5. Word processors
D.	 1. d	 2. c	 3. a	 4. e	 5. b

ItLet's Do

A.	 1.	 An Operating system serves as an interface between the user and the hardware.

	 2.	 MS word, MS PowerPoint & Coral draw are the three general purpose software.

	 3.	� An Operational Support System (OSS) is a group of computer programs. It is used by 
Telecommunication Service Providers (TSP) for monitoring, controlling, analyzing and managing 
a computer or telephone network system. It is also called Operation Support System.

2.
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B.	 1.	� System software is the most important software to operate a computer. System software 
can be classified into three categories: Operating System, Programming Software and Utility 
Software.

	 2.	� Programming software is the software used by the computer to understand and convert 
the instructions by programming language into machine language. Compilers, assemblers, 
debuggers, interpreters, etc. are examples of programming software.

	 	� An assembler is a program used to translate assembly language into machine language so 
that the computer can understand it. Whereas, an interpreter is a separate program that 
converts the entire source program into machine language before executing it. An interpreter 
translates and executes one statement at a time.

	 3.	� (This question was printed incorrectly in the book. Please correct it in your textbook.) 

	 Ques. What is application software? Explain multimedia software.

	 Ans. �It is a program designed to help users perform specific tasks. It is designed to be used by 
end-users. 

		�  Multimedia Software are used to combine the text with graphics, videos and sounds. Therefore, 
it is called multimedia software. Some commonly used multimedia software are Windows 
Media Player, Windows Movie Maker, Picasa, Inkspace, Media Monkey, etc.

	 4.	 System software Application software
a. � System software is used for operating 

computer hardware as well as 
software. 

a. � Application software is used by users 
to perform particular task.

b. � It can run independently with some 
conditions. 

b. � It cannot run without the presence of 
the system software. 
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1. Word processor	 2. Anti-virus software	     3. Data compression program
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 Advanced Features of Word 2016

OneOne LearnTouch

A.	 1. a.	 2. b.	 3. b.	 4. c.	 5. c.

B.	 1. F	 2. F	 3. T	 4. F	 5. T

C.	 1. Portrait      2. Layout	 3. Subscript      4. Footer
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ItLet's Do

A.	 1.	 Footer is the text like page number that appears at the bottom of each page of the document.

	 2.	 Page margin is the white space all around the printed area of the paper.

	 3.	 Portrait & Landscape are the two types of page orientations in Word.

B.	 1.	� Find and Replace feature of Word is used to substitute a word with another word. To substitute 
a word or phrase with another word or phrase, follow these steps:

		  Step 1	 Click on Home tab.

		  Step 2	� Click on the Replace command in the Editing group. This will open Find and Replace 
dialog box.

		  Step 3	 Type the existing word or phrase that is to be changed in the Find what text box.

		  Step 4	 Type the new word or phrase in the Replace with text box.

		  Step 5	� Click on Find Next and Replace buttons for selective replacement of the text or 
click on Replace All button to replace all occurrences of the existing text with the  
new text.

	 2.	� Column is used to break the text into two columns. Whereas, Column break is used to shift 
text from one column to another.

	 3.	� Tabs move the cursor one-half inch by default. They work when we press the Tab key on the 
keyboard. The position where the cursor moves on pressing the Tab key is called Tab stop. 
If we place the cursor at the beginning of a paragraph and press Tab key, the first line of the 
paragraph gets indented by ½ inch.
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A.	 1. text        2. Home        3. Text Effect, Font        4. Shadow        5. Shadow Effect.
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 Graphics in Word 2016

OneOne LearnTouch

A.	 1. b.	 2. a.	 3. c.	 4. c.	 5. a.

B.	 1. Shapes    2. Insert	    3. WordArt      4. 3D

C.	 1. Shapes    2. WordArt    3. Picture    4. Symbol

ItLet's Do

A.	 1.	 Bevel adds thickness and rounded edges to shapes.

	 2.	� Word 2016 comes with a set of readymade shapes that we can use in our document. We can 
resize, rotate, flip, color, and combine the shapes with other shapes to make more complex 
shapes in Word.

	 3.	 Symbols are punctuations or special characters generally not found on the keyboard.

B.	 1.	 To change the outline colour of the shape, follow these steps:
	 	 Step 1	 Click on the shape to select it. Click on the Format tab
		  Step 2	� Click on the Shape Outline command in the Shape Styles group to change outline. 

A Colours palette opens.
		  Step 3	 Choose and click on a colour.

	 2.	� WordArt allows you to create text effects that are not possible through text formatting. To 
apply WordArt effect to text, follow these steps:

		  Step 1	 Click on Insert tab.
		  Step 2	� Click on WordArt command in the Text group. 
		  A drop-down menu appears with different types of WordArt styles.
		  Step 3	 Select the desired style. A textbox will appear in the document.
		  Step 4	� Enter text in the textbox. After entering the text, click anywhere on the document 

outside the text box.

	 3.	� We can insert a saved picture or a scanned photo in our document. To insert a picture, follow 
these steps:

		  Step 1	 Place the cursor where you want to insert the picture. Click on Insert tab.
		  Step 2	 Click on the Pictures command in the Illustrations group. A sub menu appears.
		  Step 3	 Click on This Device option. The Insert Picture dialog box will appear.
		  Step 4	 Browse the location and select the desired picture.
	 	 Step 5	 Click on Insert button. The selected picture will be inserted in your document.

4.
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A.	

      
B.	 1    3    4    2
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Worksheet–1
(Based on chapters 1 to 4)

A.	

General Purpose Software

Spreadsheets Image Processing 
Software

Application Software

Customised Software

Word Processors Presentation 
Software

Desktop Publishing 
Software

Multimedia 
Processors

Database Management 
Systems

B.	 1. Ctrl + F      2. Ctrl + H	 3. Ctrl + Shift + =	 4. Ctrl + Shift + Enter

C.	 1. Insert	 	   2. Page Margin

	 3. Booting   	    4. Lady Ada Lovelace

D.	 1. �In 1944, Prof. Howard Aikens built the first electro-mechanical powered computer named 
Mark-I.

	 2. �A computer provides a high degree of accuracy. Every calculation is performed with the same 
accuracy.

	 3. The WordArt gallery contains different types text styles to create text effects.
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Test Sheet–1
(Based on chapters 1 to 4)

Section A
A.	 1. c	 2. b	 3. a
B.	 1. F	 2. F	 3. F
C.	 1. Subscript	 2. Lady Ada Lovelace	 3. Disk defragmenter
Section B
A.	 1.	Fourth Generation computers used microprocessors.
	 2.	Multimedia Software is used to combine the text with graphics, videos and sounds.
	 3.	Page margin is the white space all around the printed area of the paper.
B.	 1.	� WordArt allows you to create text effects that are not possible through text formatting. To 

apply WordArt effect to text, follow these steps:
	   Step 1	 Click on Insert tab.
	   Step 2	� Click on WordArt command in the Text group. A drop-down menu appears with 

different types of WordArt styles.
	   Step 3	� Select the desired style. A textbox will appear in the document.
	   Step 4	� Enter text in the textbox. After entering the text, click anywhere on the document 

outside the text box.
	 2.	The two features of fifth-generation computers are:
	 	 (i) Use artificial intelligence. 
	 	 (ii) Improved size, cost, speed and performance.
	 3. �System software is the most important software to operate a computer. System software 

can be classified into three categories: Operating System, Programming Software and Utility 
Software.

 Presentation Software—Special Effects

OneOne LearnTouch

A.	 1. b.	 2. c.	 3. c.	 4. c.

B.	 1. Placeholder    2. Design    3. Format    4. Justify

C.	 1. d	 2. c	 3. b	 4. a

5.
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ItLet's Do

A.	 1.	� A placeholder is a box in PowerPoint that contains dotted lines and are used to insert images, 
text, shapes, etc.

	 2.	� PowerPoint templates are well-developed presentations. We only need to change the text 
and our presentation is ready.

	 3.	� Alignment helps you to align the text of the slide in various directions. The four types of 
alignment are Align Left, Align Right, Center and Justify.

B.	 1.	 To insert Online pictures in the document, follow these steps:

		  Step 1	 Place the cursor where you want to insert the picture. Click on Insert tab.

		  Step 2	 Click on Pictures command in the Illustration group. A sub menu appears.

		  Step 3	� Click on the Online Pictures option. An Online Pictures dialog box opens with different 
categories of pictures. Select the picture, you want to insert.

		  Step 4	� If you do not find what you are looking for, type in the Bing image search text box 
and press the Enter key. The Online pictures appear. Select a picture. The Insert button 
will be change into Insert (1).  

		  Step 5	 Click on the Insert (1) button. The selected picture will be inserted in your document.

	 2.	 To insert shapes on the slide, follow these steps:

		  Step 1	 Click on Insert tab.

		  Step 2	 Click on Shapes command in the Illustration group.

		  Step 3	 Choose a desired shape from the drop down menu.

			   The desired shape will be inserted on the slide.

	 3.	� A theme is a set of predefined layouts that can be used to add a professional touch to your 
presentations. 

		  To add WordArt to a slide, follow these steps:

		  Step 1	 Click on Insert tab.

		  Step 2	 Click on WordArt command in the Text group.

		  Step 3	 Select the desired style. A textbox will appear in the document.

		  Step 4	� Enter text in the textbox. After entering the text, click anywhere on the document 
outside the text box.

Crack CodeThe

A.	 1.  ‘Insert picture’ feature can be used to insert pictures in the slides.
	 2. � ‘Built-in templates’ can be used to add templates in the slide to make it look more colorful 

& attractive.



9 Touchpad iPRIME (Version 2.1)-V  (Answer Key)

B.	 There are only 5 words. Please correct in your book.
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 An Introduction to Scratch Programming

OneOne LearnTouch

A.	 1. a.	 2. b.	 3. a.	 4. c.	 5. c.

B.	 1. backdrop    2. stage    3. brown    4. blocks

C.	 1. F	 2. F	 3. T	 4. T

ItLet's Do

A.	 1.	Feature of Scratch
		  (i)	 Easy to understand and learn.
		  (ii)	 It has tools for creating interactive stories and games.

	 2.	Sprite is an object that we see on the Scratch stage. The ‘Cat‘ is the default sprite.
	 3.	Events blocks are used to sense events.
	 4.	A backdrop is a background of the stage.

B.	 1.	 Low Level Language (LLL) High Level Language (HLL)
A Low Level Language (LLL) is a 
programming language that is machine 
dependent. A machine dependent 
language runs only on one particular 
type of computer.

High Level Language (HLL) is a 
programming language that enables a 
programmer to write programs that are 
machine independent.

6.



 Touchpad iPRIME (Version 2.1)-V  (Answer Key)10

	 2.	� Sound blocks are used to control sounds. These blocks control the playback and volume of 
the sound files selected by you. “play sound meow” block is an example of Sound blocks.

	 3.	� Motion Blocks are used to control the sprite movement. When you click on the Motion button, 
you will see the programming blocks that can be used with the sprite for its placement, 
direction, rotation and movement.

	 4.	To save a project, follow these steps:
		  Step 1	Click on the File menu.
		  Step 2	Click on Save option from the drop-down menu. Save Project dialog box appears.
		  Step 3	Choose the location and type project name in File name: box.
		  Step 4	Click on Save button.

Crack CodeThe

1. Stage	 2. Shrink sprite      3. Green Flag      4. Grow sprite      5. Scratch

Do yourself.

 Internet Services

OneOne LearnTouch

A.	 1. a.	 2. c.	 3. b.	 4. b.

B.	 1. F	 2. T	 3. T	 4. F	 5. F

C.	 1. Facebook    2. Dial-up    3. Online shopping    4. Wi-Fi    5. Internal Modem

ItLet's Do

A.	 1.	� Modem stands for Modulator Demodulator. It is generally used when users want to access 
Internet service provided by the Internet Service Provider (ISP) through their telephone line.

	 2.	� Online shopping allows us to buy various products such as grocery items, clothes, electronic 
gadgets, books, etc. We need not to leave our home for shopping. We can buy from our 
home through Online shopping websites. 

	 3.	� Online chatting allows us to interact with other people through Online chatting apps. It can 
be accessed to meet new people and make friends.

7.
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	 4.	Facebook, twitter & linkedin are social networking websites.
B.	 1.	Wi-Fi is one of the numerous ways to connect your computer to the Internet.
	 	 Difference between Wi-Fi and broadband:

	 	

Wi-Fi Broadband
a. � Wi-Fi uses radio frequency to connect 

to the Internet. Wireless connections 
are possible through the modem, 
which picks up Internet signals and 
sends them to computers.

a. � Broadband is provided through either 
cable or telephone companies. It is 
significantly faster than a dial-up 
connection and makes or receives 
phone calls.

b. � Wi-Fi does not require cable to 
provide Internet access.

b. � A broadband connection provides 
Internet access only through cable.

	 2.	� Etiquettes are the rules that are expected to be followed while meeting others or 
communicating with others. In Online communication, you may not be face to face with 
the person. There may be a situation when the person may misunderstand your remark. In 
order to avoid misunderstanding, a set of rules have been designed which are expected to be 
followed during Online conversation. This set of rules are  known as Netiquettes. It basically 
stands for Network Etiquettes.

	 3.	� E-mail stands for Electronic Mail. It allows us to send or receive electronic messages which 
can be text, picture and sound. With e-mail, we can communicate quickly and easily with 
millions of people across the world. It is an essential tool for business. It is also excellent for 
keeping in touch with family and friends.

Crack CodeThe

1. ISP      2. Internal Modem	 3. Social Networks	   4. Search Engines	 5. Hotspot

Do yourself.
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Worksheet-2
(Based on chapters 5 to 7)

A.	

Blocks
Palette

Menu bar

Delete

Duplicate

Grow

Shrink

Sprite

Stage

Scripts Area

B.	 1. WHATSAPP    2. NETIQUETTES    3. ALIGNMENT    4. MODEM    5. PRESENTATION

C.	 1. c	 2. d	 3. b	 4. a

Test Sheet–2
(Based on chapters 5 to 7)

Section A
A.	 (This question was printed incorrectly in your book. Please correct it in your textbooK.)
	 1.  We can insert the ready-made templates through the .......... tab.
	      (i)  Insert	 (ii) Design	            (iii) File
	 Ans. (iii)
	 2. (i)	 3. (iii)
B.	 1. F	 2. F	 3. F
C.	 1. Wi-Fi      2. stage      3. Place holder

Section-B

A.	 1.	There are four types of alignments in PowerPoint - Align Left, Align Right, Center and Justify. 
	 2.	Events blocks are used to sense events which run the scripts.
	 3.	1. Facebook      2. Instagram      3. Twitter

B.	 1. �A theme is a set of predefined layouts that can be used to add a professional touch to 
your presentations. The Design tab in PowerPoint provides a variety of options for theme 
backgrounds.
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	 2.	To insert a WordArt on the slide, follow these steps:
	 	 Step 1	 Click on Insert tab.
	   Step 2	 Click on WordArt command in the Text group.
	   Step 3	 Select the desired style. A textbox will appear in the document.
	   Step 4	� Enter text in the textbox. After entering the text, click anywhere on the document 

outside the text box.

	 3. a. �E-mail stands for Electronic Mail. It allows us to send or receive electronic messages which 
can be text, picture and sound. With e-mail, we can communicate quickly and easily with 
millions of people across the world.

	   b. �Dial-up requires users to link their phone line to a computer in order to access the Internet. 
It doesn’t allow users to make or receive phone calls through phone service while using 
the Internet.




